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Course Information 
Complete for all courses
	Course Prefix
	Course Number
	Course Title
	Textbook

	CMPS	2650	Linux Environment and Administration	ISBN: 0131478230 and ISBN: 0131480057


Type of Course Conversion
Select Type of Course Conversion:   Changed  
	Course Type
	Definition
	Information Needed

	New
	A new course is proposed. The rationale, place in the curriculum, and resource implications are contained in the accompanying proposal summary. This form contains the proposed course number, title, default textbook, catalog description, and PeopleSoft entries.
	Textbook
Syllabus 
Catalog Description
PS Catalog

	Unchanged
	The course has been offered in the last five years and will be converted from a 5-quarter-unit course into 3-semester unit course with no other changes in the catalog, PeopleSoft system, or course articulation.
	Textbook
Syllabus

	Changed
	The course has been offered in the last five years and will be converted into a 3-semester unit course (or closest semester equivalent) with the changes indicated in this document. Unless otherwise indicated, there will be no other changes in the catalog, PeopleSoft system, or course articulation.
	Textbook
Syllabus 
Updates To (if applicable)
Catalog Description
PS Catalog

	Elective Inactivation
	The course is an elective course, will be inactivated, and will no longer be printed in the catalog.  The course can be reactivated if it will be consistently taught. Since the course is not required in any program, there will be no need to make student accommodations for this category.   
	 No additional information required

	Required Inactivation
	The course was a required course that will not be offered in the semester system.  If an outside department requires the course, that department/program chair will need to approve the accommodation.  
Describe Accommodation:  List whether students will be accommodated by a waiver of that requirement, a substitution, or some other action.
 [Enter Accomodation Here]
	Accommodation


Catalog Description and Course Syllabus
	IMPORTANT INSTRUCTIONS  

	· To turn on “Track Changes” locate Review > Track Changes in the top menu and then make your proposed changes to the catalog description.   Need Help ?  See Tip Sheet
· To attach the Course Syllabus, locate Insert > Object > Attach as File and browse to locate and upload your syllabus.  Need Help ?  See Tip Sheet
· To submit the course, follow these steps:
1. Save the file using the Course Name and Number as the filename.  Example:  MAT 320
2. When done, attach the file to an email and send the email to  nsmecourses@share.calstate.edu


Catalog Description
If changes to the catalog description are proposed, enter the existing description and make the proposed changes with tracking on to show the changes. Existing course descriptions are found here.
	Catalog Description
	CMPS 2650 Linux Environment and Administration (4)
This course covers common Linux commands, shell scripting, regular expressions, tools and the applications used in a Linux programming environment. The tools to be introduced include make utility, a debugger, advanced text editing and text processing (vi, sed, tr). These basic skills are extended to cover the knowledge and skills critical to administering a multi-user, networked Linux system. Administrative topics include kernel and network configuration, managing daemons, devices, and critical processes, controlling startup and shutdown events, account management, installing software, security issues, shell scripting. Many concepts will be demonstrated during hands-on labs. Each week lecture meets for 150 minutes and lab meets for 150 minutes. Prerequisite: None.
CMPS 215 Unix Programming Environment (3)
This course covers common Unix commands, shell scripting, regular expressions, tools and the applications used in a Unix programming environment. The tools to be introduced include make utility, a debugger, advanced text editing and text processing (vi, sed, tr). Each week lecture meets for 100 minutes and lab meets for 150 minutes. Prerequisite: None.

CMPS 216 Unix System Administration (3)
This course covers the knowledge and skills critical to administering a multi-user, networked Unix system. The course assumes a basic knowledge of Unix commands and an editor (vi or Emacs). Topics include: kernel and network configuration, managing daemons, devices, and critical processes, controlling startup and shutdown events, account management, installing software, security issues, shell scripting. Many concepts will be demonstrated during hands-on labs. Each week lecture meets for 100 minutes and lab meets for 150 minutes. Prerequisite: CMPS 215.



Attach Course Syllabus
Attach the master syllabus or sample syllabus to this template by placing your cursor after this paragraph, then locating the Insert Tab in the top ribbon and find Insert > Object > Attach as File.  

> 
Changes to PeopleSoft Catalog  (only required for new courses)
You can skip this section for most course modifications that require no changes to prerequisites or modes of instruction.  If changes are necessary, please enter the changes below. Use only the primary component unless the course involves two modes of instruction (combined lecture/lab course)
	Course Components
	Component Units
	CS#
	Grading Basis*
	Pre-requisites
	Corequisites
	Action or Changes Required

	Primary Course Component
	3
	C04-Discussion	N=Graded	None
	
	

	Secondary Course Component (optional)
	1
	C16-Sci Lab	[Grading Basis (Secondary)]	
	
	


* RP Grading Basis requires approval from the Academic Programs office.
[bookmark: _Approval_Cycle]Review and Approval Cycle
Please select one value from the following drop-down field that represents the review/approval cycle.   Each value triggers a workflow notification to start review by the department, curriculum committee, dean, and final approval.
Select Review and Approval Cycle:   Curriculum Committee Review
Reviewers
Please enter the name of who is conducting the review for each step of the review cycle.
	Review Cycle
	Name 
	Date Complete
	Comments / Revision Requests

	Department 
	Melissa Danforth	8/8/2014	

	Curriculum Committee 
	Melissa Danforth	[CC Review Date]	

	Q2S Exceptions Committee
	[Q2S CCC Chair]	[Q2S CCC Review Date]	This Review Level only applies to exceptions and interschool programs.

	Dean  (Final Approval}
	[Dean Approver]	[Dean Approval Date]	
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         CMPS 2650 Linux Environment and
        Administration 

      
         Catalog Description 

      CMPS 2650 Linux Environment and
        Administration (3 + 1)

      This course covers common Linux
        commands, shell scripting, regular expressions, tools and the
        applications used in a Linux programming environment. The tools
        to be introduced include make utility, a debugger, advanced text
        editing and text processing (vi, sed, tr).  

        These basic skills are extended to cover the knowledge and
        skills critical to administering a multi-user, networked Linux
        system.  Administrative topics include kernel and network
        configuration, managing daemons, devices, and critical
        processes, controlling startup and shutdown events, account
        management, installing software, security issues, shell
        scripting. Many concepts will be demonstrated during hands-on
        labs. Each week lecture meets for 150 minutes and lab meets for
        150 minutes.  
      
         Prerequisites by Topic 

      None.
      
         Units and Contact Time 

      4 semester units. 3 units lecture (150 minutes), 1 unit lab (150
      minutes)

      
         Type 

      Elective skill development, recommended for Computer Science
      majors.  

      
         Required Textbook 

      A Practical Guide to Linux Commands, Editors and Shell
      Programming, 1st edition. Mark G Sobell. Publisher: Prentice Hall,
      2005. ISBN: 0131478230

      Unix and Linux System Administration Handbook. Nemeth, Snyder, et
      al. Prentice Hall. The current edition is the 4th edition, ISBN
      0-13-148005-7

      
         Recommended Textbook and Other
        Supplemental Materials 

      Linux Pocket Guide. Daniel J. Barrett. Publisher: O'Reilly, 2004.
      ISBN: 0596006284 Linux Administration: A Beginner’s Guide,
        Sixth Edition, Wale Soyinka, McGraw-Hill,

      ISBN-13: 978-0-07-176758-3

        Essential Linux Administration: A Comprehensive Guide for
        Beginners, Chuck Easttom, Cengage Learning PTR, ISBN-13:
      978-1435459564
      
         Coordinator(s) 

      Steve Garcia
      
         Student Learning Outcomes

      

      Ability to work at the Linux/Unix command line, edit and search
      text files and understand and manage file permissions.

      Ability to work remotely at both the command line and using
      graphical interfaces.

      Ability to write simple to moderately complex shell scripts.

      Ability to use the specialty programming utilities available for
      unix-like environments.

      Ability to understand and configure unix-like servers, including
      startup files, filesystems, networking, user accounts, hardware,
      and backup.

      Ability to understand and configure basic system services
      including backup, periodic services, DNS and email.

      Ability to understand the core concepts behind information
      security and the best ways to approach security.

      An understanding of what further topics to pursue.

      

       ABET Outcome Coverage 

      Not applicable to this course.
      Lecture Topics and Rough Schedule 

       


      
        
          
            		Sobell Chapter 1, 2, 3 and 6

            
            		Intro, getting started, command line and vim editor

            
            		Week 1

            
          


          
            		Sobell Chapter 4 and 5

            
            		Linux filesystem and the shell

            
            		Week 2

            
          


          
            		Sobell Chapter 1 and 3

            
            		X11, networking, command line utilities

            
            		Week 3

            
          


          
            		

            
            		Regular expressions and grep

            
            		Week 4

            
          


          
            		Sobell Chapter 6 and 13

            
            		Regular expressions, vim and sed

            
            		Week 5

            
          


          
            		Sobell Chapter 8 and 11

            
            		BASH and programming the shell

            
            		Week 6

            
          


          
            		Sobell Chapter 10

            
            		Programming tools

            
            		Week 7 and 8

            
          


          
            		Nemeth Chapter 1, 32, 24

            
            		Background, policies and virtualization

            
            		Week 9

            
          


          
            		Nemeth Chapter 3, 6, 8

            
            		Booting, startup scripts and filesystems,
              storage

            
            		Week 10

            
          


          
            		Nemeth Chapter 5, 4, 7

            
            		Root, processes and daemons, adding users

            
            		Week 11

            
          


          
            		Nemeth Chapter 9, 10, 13

            
            		Cron, backups, kernel

            
            		Week 12

            
          


          
            		Nemeth Chapter 11, 14, 15

            
            		Logging, networking, routing

            
            		Week 13

            
          


          
            		Nemeth Chapter 17, 20

            
            		DNS, Email

            
            		Week 14

            
          


          
            		Nemeth Chapter 22

            
            		Security

            
            		Week 15

            
          


        
      


      
       Design Content Description 

        Not applicable to this course.
       Prepared By 

      Steve Garcia on July 30, 2014

       Approval 

      Approved by CEE/CS Department on [date] 

      Effective [term] 

  
